State Bank of India
Central Recruitment & Promotion Department
Corporate Centre, Mumbai
Phone: 022-22820427, Email: crpd@sbi.co.in

RECRUITMENT OF SPECIALIST CADRE OFFICERS IN SBI ON REGULAR BASIS
ADVERTISEMENT NO: CRPD/SC0O/2022-23/16

ONLINE REGISTRATION OF APPLICATION & PAYMENT OF FEES: FROM 31.08.2022 TO 20.09.2022

State Bank of India invites Online application from Indian citizens for appointment to the following Specialist Cadre Officers posts on regular basis. Candidates

are requested to apply Online through the link given on Bank’s website
https://bank.sbhi/web/careers or https://www.sbi.co.in/web/careers

wN e
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The process of Registration is complete only when fee is deposited with the Bank through Online mode on or before the last date for payment of fee.

Before applying, candidates are requested to ensure that they fulfil the eligibility criteria for the post as on the date of eligibility.

Candidates are required to upload all required documents (brief resume, ID proof, age proof, caste certificate, PWD Certificate (if applicable), educational
gualification, experience etc. failing which their application/candidature will not be considered for shortlisting/ interview.

Before applying, a candidate must check his/her eligibility for the post. In case, it is found that the candidate is not eligible for the post, his/her candidature
will be cancelled.

A candidate can not apply for more than one post. If it is found that a candidate has applied for more than one post, his application last in point of time will
only be considered for shortlisting.

Short listing will be provisional without verification of documents. Candidature will be subject to verification of all details/ documents with the original when a candidate
reports for interview (if called).

In case a candidate is called for interview and is found not satisfying the eligibility criteria (Age, Educational Qualification and Experience etc.) he/ she will neither be
allowed to appear for the interview, nor be entitled for reimbursement of any travelling expenses.

Candidates are advised to check Bank’s website https://bank.sbi/careers or https://www.sbi.co.in/careers regularly for details and updates (including the list of
shortlisted/ selected candidates). The Call (letter/ advice), where required, will be sent by e-mail only (no hard copy will be sent).

ALL REVISIONS/ CORRIGENDUM (IF ANY) WILL BE HOSTED ON THE BANK’S WEBSITE ONLY.

In case more than one candidate score same marks as cut-off marks in the final merit list (common marks at cut-off point), such candidates will be ranked in the merit
according to their age in descending order.

Hard copy of application & other documents not to be sent to this office.

A. DETAILS OF POST/VACANCY/ GRADE (NATURE OF ENGAGEMENT)/SCALE/ AGE /PLACE OF POSTING/ /SELECTION PROCESS:

Vacancy (:sggn
30.06.2022) .
Sr. Place of Selection
NoO. Name of Post Gﬁdte/Sca]Ice posting® Procedure
Total UR | oBC | EWS | sC ST PWD Erg ature of o | win. | Max
Vacancy (vn* 949 ' ’
Manager (Data 26 35
1. Scientist- 11 5 4 - 1 1 1 MMGS-III
- Years Years
Specialist) (Regular)
Dy. Manager (Data
2. Scientist- 5 3 1 - - 1 1
Specialist .
P ) Navi Shortlisting-
MMGS-II Mumbai cum-
interaction
System Officer (Regular) 24 32
(Specialist)- Years Years
i. Database
3 Administrator 3 1 1 ) 1 ) 1
ii. Application
Administrator
iii. System
Administrator

ABBREVIATION: UR- Unreserved, EWS-Economically Weaker Section, OBC-Other Backward Class, SC-Scheduled Caste, ST-Scheduled Tribe, PWD-Persons with
Disabilities VI-Visually Impaired, MMGS- Middle Management Grade Scale

* Reservation is horizontal and is included in the vacancy of the respective parent category.

# THE BANK RESERVES THE RIGHT TO POST OR TRANSFER THE SERVICES TO ANY OF THE OFFICES OF STATE BANK OF INDIA IN INDIA, OR TO DEPUTE TO ANY OF ITS ASSOCIATES/SUBSIDIARIES
OR ANY OTHER ORGANIZATION DEPENDING UPON THE EXIGENCIES OF SERVICE.

IMPORTANT POINTS:

The number of vacancies including reserved vacancies mentioned above is provisional and may vary according to the actual requirement of the Bank.

Candidate must possess the relevant full-time experience as on specified date.

The relevant experience certificate from employer must contain specifically that the candidate had experience in that related field as required.

Candidate belonging to reserved category including Person with Disabilities for whom no reservation has been mentioned are free to apply for vacancies announced
for General category provided they fulfil all the eligibility criteria applicable to General category.

The reservation under various categories will be as per prevailing Government Guidelines.
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Vi. A declaration will have to be submitted in prescribed format by candidates seeking reservation under OBC category stating that he/she does not belong to the creamy

layer as on last date of online registration of application. OBC certificate containing the 'Non-creamy layer' clause, issued during the period 01.04.2022 to the date of

interview, should be submitted by such candidates, if called for interview.

Vi, PWD candidate should produce a certificate issued by a competent authority as per the Government of India Guidelines.

Viil. Relaxation in age is as per Govt. of India Guidelines.

B. DETAILS OF BASIC QUALIFICATION, PREFERRED QUALIFICATION, POST QUALIFICATION EXPERIENCE (AS ON 30.06.2022):

I. EFOR POST NO.1- MANAGER (DATA SCIENTIST-SPECIALIST):

PREFERRED POST

Science/lIT/Data

Computer

Science/Machine Learning and Al with | any
60% marks or equivalent grade.

/Al/Natural
Processing,

specialisation in finance and
certification in ML

web Crawling
and Neural Networks.

Language

qualification) experience in Data Science / Al ML
Model Development.

PREFERRED
ALIFICATION EXPERIENCE
BASIC QUALIFICATIONS QUALIFICATIONS POST QUALIFICATION EXPERIENCE QU CATIO C
B. Tech or B.E./M. Tech or M.E. in | MBA / PGDM with | Minimum 5 years of overall (post basic education | Experience in financial sector /Bank/

NBFC/Insurance/Investment firm

[I. EOR POST NO.2- DY. MANAGER (DATA SCIENTIST-SPECIALIST):

Computer Science/IT/Data
Science/Machine Learning and Al with
60% marks or equivalent grade.

specialisation in finance and
any certification in ML
/Al/Natural Language
Processing, web Crawling
and Neural Networks.

qualification) experience in Data Science / Al ML Model

Development.

firm

PREFERRED PREFERRED POST
BASIC QUALIFICATIONS QUALIFICATIONS POST QUALIFICATION EXPERIENCE QUALIFICATION EXPERIENCE
B. Tech or B.E./M. Tech or M.E. in | MBA |/ PGDM with | Minimum 3 years of overall (post basic education | Experience in financial sector

/Bank/ NBFC/Insurance/Investment

lIl. FOR POST NO.3- (SYSTEM OFFICER-SPECIALIST):

BASIC QUALIFICATIONS

POST QUALIFICATION EXPERIENCE

PREFERRED POST QUALIFICATION EXPERIENCE

Database
Administrator

Application
Administrator

System
Administrator

Database
Administrator

Application
Administrator

System
Administrator

B. Tech or B.E./M. Tech
or M.E. in Computer
Science/ IT/ Electronics &
Communication
Engineering/Machine
Learning and Al with 60%
marks or equivalent
grade.

3+ years of
overall
experience in
database
administration
and
management.

3+ years of
overall
experience in
Weblogic
application
administration
and management
on Linux.

3+ years of overall
experience in
system

administration and
management on
Linux/RedHat Core
Operating System
(Container) /Ansible

scripting.

Oracle
Professionals

Strong Knowledge of

DB2/Graph/NoSQL

Database/Oracle DBA

preferred.

Certified

Weblogic

Strong Knowledge of
Suite
Administration on Linux

Strong
Knowledge of
managing
Linux/RedHat
Core Operating
system/
ANSIBLE scripts

C.(I). (FOR POST NOs. 1 &2) DETAILS OF SPECIFIC SKILL, JOB PROFILE (DETAILED DESCRIPTION OF ROLE, RESPONSIBILITIES & FUNCTION) AND KEY
RESPOSIBILITY AREA:

SR.

NO POST SPECIFIC SKILLS JOB PROFILE KRA
1. Manager e Experience in e Understanding of Familiarity with Implement e Project on
(Data implementations of MLOps, AutoML public cloud Machine Learning Advanced
Scientist- Machine learning/ and Auto-adaptive Al/ML / Avrtificial machine
Specialist) Artificial  Intelligence machine learning. development Intelligence/ learning/ Deep
solutions including AWS, Natural Language Learning/ Big
_ e Understanding of GCP, Azure. Processing / data/  Artificial
e Experience of storage Parsing tools to Intelligence
implementing Deep htg t h Excellent improve the
Learning algorithms. :;CDI(;; ures ste communication operational e Collaborate with
) skills and ability efficiency. Business, Data
» Experience on Warehouse, Data to work as part Operation and IT
visualisation tools Lake and Lake of a multi- Designing  and Infrastructure.
including houses. cultural and implementation of
PowerBl/Tableau. geographically Big data scalable
’ _ e Understanding of distributed workflow systems
e 2+ years’ experience Time series product using Big Data
with programming forecasting, development Technologies
languages frequently team.




used in data science
(R/Python/PySpark).

Knowledge of Java
and IBM SPSS would

be a plus.
e 2+ years’ experience
* I\D/I)Qna er in Relational
(Datag Databases OR any
Scientist- NoSQL  databases
. including Graph
Specialist) databases.

e End to end Data
Science Life Cycle
experience from data
extraction to modelling
and its validation

Batch/Real Time
analytics and
model deployment
understanding.

Understanding of
concepts including
Data Virtualisation,
Data Fabrics, Data
Mesh

Self-motivated,
pro-active and
demonstrating
an exceptional
drive towards
delivery.

Deliver new
functionality  for
the internal
production
platform and the
client delivery
platform.

Closely
collaborate  with
Product
Management,
Business, Quality
Assurance, Data
Operation and IT
Infrastructure.

RESPOSIBILITY AREA:

(). (FOR POST NO.3) DETAILS OF SPECIFIC SKILLS, JOB PROFILE (DETAILED DESCRIPTION OF ROLE, RESPONSIBILITIES & FUNCTION) AND KEY

SPECIFIC SKILL

JOB PROFILE & KRA

Database Administrator:

3 years experience in database
administration and management.
Certified Database Administrator on
Oracle is preferred.

Software installation, configuration and maintenance:
o Install, configure and manage cluster based database setup's in Oracle or Cloud database or NoSQL
database
o Data migration
o Realtime data synchronization technology implementation and maintenance

2+ years experience in Relational e Database Backup and Recovery management
Databases OR any NoSQL databases e Security: Implementing and monitoring best practices to minimize risks
including Graph database OR DB2. e Capacity Planning
Experience in installation, migration. o Performance Monitoring: Monitoring databases of performance issues and implementing corrective /preventive
Upgradation of database cluster e controls for performance improvement
setup. e Database Tuning: Proactively tune a system based on application and usage instead of waiting until a problem
Familiarity with cloud based database e develops
Familiarity with Data Lake e Troubleshooting: Quickly understand and respond to problems when they occur.
o DC/DR server configuration set-up, maintenance and capacity planning
e Data Extraction, Transformation, and Loading: Efficiently importing large volumes of data that have been
Extracted from multiple systems into a data warehouse environment.
e Specialized Data Handling: Managing a very large database (VLDB) may require higher-level skills and
additional monitoring and tuning to maintain efficiency.
Application Administrator: o Installation/ migration/ Up-gradation of WebLogic on LINUX/UNIX
3 years experience in Weblogic e Sizing, capacity planning, evaluation of application setup.
application administration and e Experience of web application deployment on WebLogic using console & command line in cluster
management on Linux e setup
Certified Weblogic Administrator is e Integration of web servers/application servers and DB servers.
preferred ¢ Management of SSL certs on webservers / app servers
Experience in installation, migration. ¢ Troubleshooting of logs, providing logs on demand from different teams (Architects, developers and
Upgradation of Weblogic cluster setup. o validations)
Familiarity with cloud based application e Providing thread /heap dump as per requirement
architecture e Working with different teams during production deployment Automation of the tasks using shell
e scripting
e Ensure periodic health checks and take appropriate steps for high availability
e Ensure that predefined SLA is maintained
e Ensure that 100% BCP is provisioned in all respect
e Responsible for implementation of security requirements.
e Responsible for Patch Management as per Bank’s IT/IS Policy
e Ensure documentation of entire architecture design
e Migration to new systems, capacity planning, performance monitoring and improvement
System Administrator: ¢ Installation/ migration/ Up-gradation of setup with RedHat Linux/ RedHat Core Operating System
3 year experience in system e Sizing, capacity planning, evaluation of setup.
administration and management on o Experience of cluster based deployments /container deployments to support application/database architecture
Linux/RedHat Core Operating e Experience of process automation using Ansible scripting
System(Container) /Ansible scripting ¢ Integration of web servers/application servers and DB servers.
Experience in installation, migration. e Troubleshooting of logs, providing logs on demand from different teams (Architects, developers and validations)
Upgradation of setup with RedHat e Providing thread /heap dump as per requirement
Linux/ RedHat Core Operating e Working with different teams during production deployment Automation of the tasks using shell scripting
Systg.m.. ) i e Ensure periodic health checks and take appropriate steps for high availability
Fam_|I|ar|ty with container based e Ensure that predefined SLA is maintained
archlt(-ecture-deployments e Ensure that 100% BCP is provisioned in all respect
Egi?lzrfggiillg :éjrtiggatlon of process e Responsible for implementation of security requirements
e Responsible for Patch Management as per Bank’s IT/IS Policy
e Ensure documentation of entire architecture design
e Migration to new systems, capacity planning, performance monitoring and improvement

D. REMUNERATION:

REMARKS: Job profile/KRAs mentioned above is illustrative. Roles/Job, in addition to above, may be assigned by the bank from time to time for the above posts.

The scale of pay applicable to respective grade
are furnished above. The official will be eligible

for DA, HRA, CCA, PF, Contributory Pension
Fund, LFC, Medical Facility, other perquisites etc.

GRADE PAY SCALE
MMGS-II Rs. (48170-1740/1-49910-1990/10-69810)
MMGS-II Rs. (63840-1990/5-73790-2220/2-78230)

as per rules in force from time to time.




E. HOW TO APPLY: Candidates should have valid email ID which should be kept active till the declaration of result. It will help him/her in getting call letter/Interview advices
etc. by email.

GUIDELINES FOR FILLING ONLINE APPLICATION

GUIDELINES FOR PAYMENT OF FEES

Candidates will be required to register themselves online through the link
available on SBI website https://bank.sbi/careers OR
https://www.sbi.co.in/careers and pay the application fee using Internet
Banking/ Debit Card/ Credit Card etc.

Candidates should first scan their latest photograph and signature. Online
application will not be registered unless candidate uploads his/ her photo
and signature as specified on the online registration page (under ‘How to
Upload Document”).

Candidates should fill the application carefully. Once application is filled-in
completely, candidate should submit the same. In the event of candidate
not being able to fill the application in one go, he can save the information
already entered. When the information/ application is saved, a provisional

Application fees and Intimation Charges (Non-refundable) is I 750/- (X
Seven Hundred Fifty only) for General/EWS/OBC candidates and no
fees/intimation charges for SC/ ST/ PWD candidates.

After ensuring correctness of the particulars in the application form,
candidates are required to pay the fees through payment gateway integrated
with the application. No change/ edit in the application will be allowed
thereafter.

Fee payment will have to be made online through payment gateway
available thereat. The payment can be made by using Debit Card/ Credit
Card/ Internet Banking etc. by providing information as asked on the screen.
Transaction charges for online payment, if any, will be borne by the
candidates.

registration number and password is generated by the system and displayed iv. On successful completion of the transaction, e-receipt and application form,
on the screen. Candidate should note down the registration number and bearing the date of submission by the candidate, will be generated which
password. They can re-open the saved application using registration should be printed and retained by the candidate.
number and password and edit the particulars, if needed. This facility of V. If the online payment of fee is not successfully completed in first instance,
editing the saved information will be available for three times only. Once the please make fresh attempts to make online payment.
application is filled completely, candidate should submit the same and vi. A provision is there to reprint the e-Receipt and Application form containing
proceed for online payment of fee. fee details, at later stage.

iv. After registering online, the candidates are advised to take a printout | vii. Application Fee once paid will NOT be refunded on any account NOR

of the system generated online application forms.

can it be adjusted for any other examination or selection in future.

F. CALL LETTER FOR INTERVIEW: INTIMATION/ CALL LETTER FOR INTERVIEW WILL BE SENT BY EMAIL OR WILL BE UPLOADED ON BANK'S WEBSITE. NO HARD COPY WILL BE SENT.

G. SELECTION PROCESS: The selection will be based on shortlisting and interview.

Shortlisting: Mere fulfilling minimum qualification and experience will not vest any right in candidate for being called for interview. The shortlisting committee constituted by
the Bank will decide the shortlisting parameters and thereafter, adequate number of candidates, as decided by the Bank, will be shortlisted for interview. The decision of the

Bank to call the candidates for the interview shall be final. No correspondence will be entertained in this regard. The shortlisted candidates will be called for interview.

Interview: Interview will carry 100 marks. The qualifying marks in interview will be decided by the Bank. No correspondence will be entertained in this regard.

Merit list: Merit list for selection will be prepared in descending order on the basis of scores obtained in interview only. In case more than one candidate scores the cut-off
marks (common marks at cut-off point), such candidates will be ranked according to their age in descending order, in the merit list.

H. HOW TO UPLOAD DOCUMENTS:

a. Details of Document to be uploaded:
I.

il.
iii.

Brief Resume (PDF)
ID Proof (PDF)
Proof of Date of Birth (PDF)

d. Document file type/ size:

i.
.

iii.
iv.

All Documents must be in PDF

Page size of the document to be A4
Size of the file should not be exceeding 500 kb.
In case of Document being scanned, please ensure it is saved as PDF and size

Iv. PWD certification (if applicable) (PDF) not more than 500 kb as PDF. If the size of the file is more than 500 kb, then
V. Educational Certificates: Relevant Mark-Sheets/ Degree Certificate (PDF) adjust the setting of the scanner such as the DPI resolution, no. of colors etc.,
VI. Experience certificates (PDF)/Driving Licence (Two-wheeler) (PDF) during the process of scanning. Please ensure that Documents uploaded are
vii.  Form-16/Offer Letter/Latest Salary slip from current employer (PDF) clear and readable.
viil.  NOC (If applicable) (PDF)
iX.  Recent Photograph
X. Signature

b. Photograph file type/ size:

iv.

Photograph must be a recent passport style colour picture.

Size of file should be between 20 kb - 50 kb and Dimensions 200 x 230
pixels (preferred)

Make sure that the picture is in colour, taken against a light-coloured,
preferably white, background.

Look straight at the camera with a relaxed face

size of the file is more than 50 kb, then adjust the settings of the scanner
such as the DPI resolution, no. of colour etc., during the process of
scanning.

e. Guidelines for scanning of photograph/ signature/ documents:

iv.

Set the scanner resolution to a minimum of 200 dpi (dots per inch)

Set Color to True Color

Crop the image in the scanner to the edge of the photograph/ signature, then
use the upload editor to crop the image to the final size (as specified above).
The photo/ signature file should be JPG or JPEG format (i.e. file name should
appear as: image01.jpg or image01l.jpeg).

v. Image dimensions can be checked by listing the folder/ files or moving the

V. If the pic.ture is taken on a sunny day, have t_he_ sun behind you, or place mouse over the file image icon.
yourself in the shade, so that you are not squinting and there are no harsh vi. Candidates using MS Windows/ MSOffice can easily obtain photo and
) shadows signature in .jpeg format not exceeding 50 kb & 20 kb respectively by using MS
VI. If you have to use flash, ensure there's no "red-eye" Paint or MSOffice Picture Manager. Scanned photograph and signature in any
Vii.  If you wear glasses make sure that there are no reflections and your eyes format can be saved in .jpg format by using ‘Save As’ option in the File menu.
can be clearly seen. The file size can be reduced below 50 kb (photograph) & 20 kb (signature) by
viii.  Caps, hats and dark glasses are not acceptable. Religious headwear is using crop and then resize option (Please see point (i) & (ii) above for the pixel
allowed but it must not cover your face. size) in the ‘Image’ menu. Similar options are available in another photo editor

. . . : also.

X Ensure that the size of the scanned image is not more than S0kb. If the | & \yiiie filing in the Online Application Form the candidate will be provided with

a link to upload his/her photograph and signature
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c. Signature file type/ size:

i
ii.
iii.
iv.
V.
Vi.

The applicant has to sign on white paper with Black Ink pen.

The signature must be signed only by the applicant and not by any other
person.

The signature will be used to put on the Call Letter and wherever necessary.

Size of file should be between 10 kb - 20 kb and Dimensions 140 x 60 pixels
(preferred).

Ensure that the size of the scanned image is not more than 20 kb.
Signature in CAPITAL LETTERS shall NOT be accepted.

f. Procedure for Uploading Document:

i.
ii.
iii.
iv.
V.

Vi.

Vii.

There will be separate links for uploading each document.

Click on the respective link "Upload"

Browse & select the location where the JPG or JEPG, PDF, DOC or DOCX file
has been saved.

Select the file by clicking on it and Click the 'Upload' button.

Click Preview to confirm the document is uploaded and accessible properly
before submitting the application. If the file size and format are not as
prescribed, an error message will be displayed

Once uploaded/ submitted, the Documents uploaded cannot be edited/
changed.

After uploading the photograph/ signature in the online application form
candidates should check that the images are clear and have been
uploaded correctly. In case the photograph or signature is not prominently
visible, the candidate may edit his/ her application and re-upload his/ her
photograph or signature, prior to submitting the form. If the face in the
photograph or signature is unclear the candidate’s application may be
rejected

|. GENERAL INFORMATION:

VI

VII.

VIII.

Before applying for the post, the applicant should ensure that he/ she fulfils
the eligibility and other norms mentioned above for that post as on the
specified date and that the particulars furnished by him/ her are correct in
all respects.

Candidates belonging to reserved category including, for whom no
reservation has been mentioned, are free to apply for vacancies announced
for General category provided they must fulfil all the eligibility conditions
applicable to General category.

IN CASE IT IS DETECTED AT ANY STAGE OF RECRUITMENT THAT AN
APPLICANT DOES NOT FULFIL THE ELIGIBILITY NORMS AND/ OR
THAT HE/ SHE HAS FURNISHED ANY INCORRECT/ FALSE
INFORMATION OR HAS SUPPRESSED ANY MATERIAL FACT(S), HIS/
HER CANDIDATURE WILL STAND CANCELLED. IF ANY OF THESE
SHORTCOMINGS IS/ ARE DETECTED EVEN AFTER APPOINTMENT,
HIS/ HER SERVICES ARE LIABLE TO BE TERMINATED.

The applicant should ensure that the application is strictly in accordance
with the prescribed format and is properly and completely filled.
Appointment of selected candidate is subject to his/ her being declared
medically fit as per the requirement of the Bank. Such appointment will also
be subject to the service and conduct rules of the Bank for such post in the
Bank, in force at the time of joining the Bank.

Candidates are advised to keep their e-mail ID active for receiving
communication viz. call letters/ Interview date advices etc.

The Bank takes no responsibility for any delay in receipt or loss of any
communication.

Candidates serving in Govt/ Quasi Govt. offices, Public Sector
undertakings including Nationalised Banks and Financial Institutions are
advised to submit ‘No Objection Certificate’ from their employer at the time
of interview, failing which their candidature may not be considered and
travelling expenses, if any, otherwise admissible, will not be paid.

In case of selection, candidates will be required to produce proper
discharge certificate from the employer at the time of taking up the
appointment.

Candidates are advised in their own interest to apply online well before the
closing date and not to wait till the last date to avoid the possibility of
disconnection / inability/ failure to log on to the website on account of heavy
load on internet or website jam. SBI does not assume any responsibility for
the candidates not being able to submit their applications within the last
date on account of aforesaid reasons or for any other reason beyond the
control of SBI.

XI.

XIl.

XII.

XIV.

XV.

XVI.

XVIL.

XVIII.

DECISIONS OF BANK IN ALL MATTERS REGARDING ELIGIBILITY,
CONDUCT OF INTERVIEW, OTHER TESTS AND SELECTION WOULD BE
FINAL AND BINDING ON ALL CANDIDATES. NO REPRESENTATION OR
CORRESPONDENCE WILL BE ENTERTAINED BY THE BANK IN THIS
REGARD.

The applicant shall be liable for civil/ criminal consequences in case the
information submitted in his/ her application are found to be false at a later
stage.

Merely satisfying the eligibility norms does not entitle a candidate to be called
for interview. Bank reserves the right to call only the requisite number of
candidates for the interview after preliminary screening/ short-listing with
reference to candidate’s qualification, suitability, experience etc.

In case of multiple application, only the last valid (completed) application will
be retained and the application fee/ intimation charge paid for other
registration will stand forfeited. Multiple appearance by a candidate for a single
post in interview will be summarily rejected/ candidature cancelled.

Any legal proceedings in respect of any matter of claim or dispute arising out
of this advertisement and/ or an application in response thereto can be
instituted only in Mumbai and Courts/ Tribunals/ Forums at Mumbai only shall
have sole and exclusive jurisdiction to try any cause/ dispute.

Outstation candidates, who may be called for interview after short-listing will
be reimbursed the cost of travelling by Railway-AC three tier (Mail or
Express only) for the shortest route in India OR the actual travel cost in India
(whichever is lower) on the basis of actual journey. Local transportation will
not be reimbursed. A candidate, if found ineligible for the post will not be
permitted to appear for the interview and will not be reimbursed any fare.
BANK RESERVES RIGHT TO CANCEL THE RECRUITMENT PROCESS
ENTIRELY AT ANY STAGE.

At the time of interview, the candidate will be required to provide details
regarding criminal cases pending against him/her, if any. The Bank may
also conduct independent verification, inter alia, including verification of
Police Records,etc. The Bank reserves the right to deny the appointment
depending upon such disclosure and/or independent verification.

For any query, please write to us through link “CONTACT US/ Post Your Query” which is available on Bank’s website (URL - https://bank.sbi/web/careers OR
https://sbi.co.in/web/careers)

The Bank is not liable for printing errors, if any.

Mumbai
31.08.2022

GENERAL MANAGER
(RP & PM)
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